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Background

e Throughout brain MRI scanning, physiological data are acquired using SA Instruments and CWE hardware
and recorded by PC-SAM and LabChart software.

* SA Instruments hardware monitors respiratory effort (pad sensor pressure), pulse oximeter signal (PulseOx)
?nd rectal temperature (fiber optic sensor “FOT1”) and regulates warming air temperature with feedback
rom FOT1.

* PC-SAM software displays these signals, calculates respiration rate, pulse rate and SpO2 from the respiratory
effort and pulse oximeter signals and generates trigger pulses to synchronize MRI acquisition with
respiration, reducing blurring artifacts in the images.

* PC-SAM logs “slow” data (rates, SpO2 and temperature) but does not store signals. PC-SAM log data is not
available until after scanning.

* To circumvent these limitations, we added SA Instruments “breakout boxes”, which convert the PC-SAM
signals and slow data to analog voltages, which are digitized by a AD Instruments PowerlLab 16/35 data
acquisition system and recorded and displayed in real time by ADI LabChart software.

* In addition to these data, PowerlLab digitizes and LabChart records and displays :

. kﬂog:c pgls)es output by the scanner marking the beginning of each fMRI dynamic (or other event programmed in the
code

* Logic pulses corresfponding to the radio-frequency (RF) pulses transmitted to excite the nuclear spins in the sample
(rat brain). For 2D fMRI, for each dynamic, one pulse is generated just prior to scanning each slice.

* Analog signals from a CWE GEMINI 02/CO2 analyzer, which monitors the gas exhaled by the anesthetized rat. The CO2
concentration (recorded in percent by volume) can be used to calculate end-tidal CO2 (EtCO2).

* Analog signal from a potentiometer (variable resistor) attached to the dose adjustment knob of the isoflurane
vaporizer supplying anesthesia gas to the rat in the magnet. This signal is calibrated to the isoflurane dose setting
using a point-by-point interpolation in LabChart.

» All of these data are recorded and displayed synchronously by LabChart, so that physiological data can be
matched to each MRI scan by identifyinﬁ the block of logic pulses corresponding to that scan and selecting
the physiological data acquired during that block.



Post-processing in LabChart

* During scanning, LabChart records both the signal waveforms and
“slow” data output from PC-SAM but does not process these data.

* Sometimes, if the quality of the respiratory effort or pulse oximeter
signal is poor, PC-SAM will output erroneous data for respiratory
rate or pulse rate, respectively.

* Most often, this occurs when the respiratory effort signal is too
small, e.g. due to improper placement of the pad pressure sensor.

e LabChart may be able to recover the missing respiration or pulse
rate data by analyzing the digitized signal after scanning.

* This is possible because LabChart allows the user to adjust many
arameters of its “Cyclic Measurements” function to achieve the
est fit. PC-SAM has no such user-adjustable fit parameters.

* The user may also insert comments in the LabChart record, either
during or after scanning. For example, after identifying the
beginning and ending of a particular fMRI scan, the user can add
comments marking these times.



Challenges to Matching
Physiological to MRI Data

Unless the operator inserted comments into LabChart each time a scan started
or ended, locating the time interval to extract must be achieved indirectly.

Even though we know the MRI scan numbers for the data to be extracted, we
can’t assume that the scans were acquired in numerical order, e.g. E9, E10,
E11,...

* Although ParaVision starts each study with a template of empty, consecutively-numbered
scans, the operator can skip, duplicate, or delete these scans during data acquisition.

. Duplilcated scans are assigned new scan numbers that succeed those loaded from the
template.

Fortunately, the approximate time at which each scan was completed is stored in
that scan’s method file.

Subtracting the known duration of each scan from its end time, we can identify
its approximate starting time.

With the approximate start and end times for each scan, we can find the
appropriate block of logic pulses in the LabChart record.

We can then use the timing of those pulses to precisely determine the beginnin
]zcand ﬁnd of each scan and therefore which physiological data should be extracte
or that scan.




Locating the Beginning
and End of a Scan



Step 1: Look up the scan numbers in the Scan Record
spreadsheet for the desired cohort and time point.

Example: Z:\STARRRS\STARRRS _inhouse\TempTransfer_01192023\C28_E_fMRI files & data\C28_E_fMRI Scan Record.xIsx
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The data for these scans will be in a folder named:

20241024 HHMMSS STM0654 STM0654 C28 E*

Where HHMMSS is the time the study was created and * reflects the fact that a study may be

repeated at the same time point. The first study for this rat will be C28 E_1 1 and a repeat
study would be C28 E_1 2. The later time points will be C28 M 1 2and C28 O 1 3.



Step 2: Locate the method parameter file for
the scan of interest.

* Go to the folder containing the study (rat-timepoint) data:
20241024 090446 STM0654 STM0654 C28 E 1 1

* Go to the subfolder for the scan of interest and open the
method file for that scan, e.g. for scan 9:

20241024 090446 STM0654 STM0654 C28 E 1 1\9\method

* Near the top, find the end time for this scan:

* ##TITLE=Parameter List, ParaVision 360 V3.3

* ##JCAMPDX=4.24

* ##DATATYPE=Parameter Values

* ##ORIGIN=Bruker BioSpin MRI GmbH

* ##OWNER=starrrs

e S$S Write Options: Symbolic Enums, RLE encoded arrays, symbol visibility
* S5 2024-10-24 10:36:56.920 -0400 starrrs@starrrs mri

* $$ /opt/nmrdata/PV-
360.3.3/data/starrrs/20241024 090446 STM0654 STM0654 C28 E 1 1/9/method

* $$ process /opt/PV-360.3.3/prog/bin/parxserver
* ##SMethod=<User:reversed EPI>



Step 3: In the LabChart record, locate
the end of the scan of interest.

* Open the LabChart *.adicht file for the study of interest, e.g.:

C28 E fMRI files & data\STM0654 C28 E\
STM0 654 _C28 E.adicht

* At the bottom of the LabChart window, right click on the X axis (time
line) and select “Time Mode...”. Select “Show as time of day”

* Scroll the timeline to locate the approximate end of the scan. In this
example, it’s 10:36:56.920.

* Place the mouse on the “RF Pulses” trace (Channel 4) and observe
the exact cursor time in the top right corner of the LabChart window.

* Move the mouse left and right until the exact cursor time matches
the end-of-scan time from the method file as closely as possible.
Right-click and choose “Set Marker”.



In LabChart, set X axis to time of day
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Scroll to approximate end-of-scan time from method file,
then move mouse in data window to display exact time at
top left. Right click and select “Set Marker”.
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Let’s zoom in around the end of scan 9.
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Now we can see the logic pulses for each slice. The end-of-scan time
from the method file is 0.524 s after true end-of-scan. Unfortunately,
this is not an exactly reproducible delay (0.498, 0.5185, 0.586,

0.595 s...). This variability may arise from variable latency in writing
data to dISk
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So the end-of-scan time from method is just approximate,
but good for identifying the correct block. In the zoomed
view, mark the actual end-of-scan.
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Mark the true end-of-scan with a comment.
The exact time is saved by LabChart.
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Press Ctrl-L or choose “Window ->
Comments” to display comments.
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Step 4: Locate the beginning of
the block of data to export.

* Close the “Zoom” window and return to the main Chart window:
“Window -> 1 STM0654 C28 E.adicht: Chart View”.

* From the marker you placed at the end of the scan, scroll to the left until
the top right window shows “-A7:30”. This should correspond to the
beginning of the first dynamic: 300 dynamics x 1.5 s

Note: The data were acquired at a very high speed (0.5 ms/point), so there
a very large number of points and scrolling can be slow and jumpy!

If you get lost, you can always go to the Comments window, select “End
scan 9” and “Go To” (bottom right corner of window).

Rather than concentrating on the time display, you can just scroll to the
beginning of the red bar (“XMTR gate 1”), but it’s easy to get lost and up in
a different scan!



Step 4: Locate the beginning of
the block of data to export.

* At the beginning of a fMRI EPI scan, there are three
“dummy” dynamics. These are used to reach steady-state
magnetization and should not be exported.

* From the marker you placed at the end of the scan, scroll
to the left until the top right window shows “-A7:30”. This
is the expected beginning of dynamic 1, since 300
dynamics x 1.5 s=450s =7 min 30 s.



Zoom in on the first five marker pulses
in channel 4.

i L.l e 3. Click on the “Zoom” icon.
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Again, we can see the logic pulses for each slice. The actual time
between marker pulses is not 1.5 s but longer by 0.5-1.0 ms
(digitization rate of 0.5 ms/point). This difference accumulates so that
the true beginning of scan is more than 450 s before true end of scan.
This difference of 207 ms seems to be consistent.
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Conclusions: Locating ends
of data block

1. The header time from a scan’s ParaVision method file
is later than the actual end-of-scan by a variable
amount. The method time can be used to find the
correct block of data to analyze, distinguishing it from
other scans.

e 2. The true end-of-scan can be marked by counting 1.5
s after the beginning of the final marker pulse.

e 3. The true beginning-of-scan is actually 450.207 s
before the true end-of-scan. The beginning of the scan
can easily be marked by skipping the first 3 (dummy)
pulses and zooming in on the beginning of the 4t
marker pulse.



Recommended Procedure for
Marking Beginning and End of Scan



Recommended procedure to find
true end-of-scan

e 1. Use the time in the header of the scan’s method file
to approximately locate the end of the scan in
LabChart.

e 2.Zoom in from just before the last marker pulse
(marking the beginning of the final dynamic) to a time
well beyond the end of the XMTR gate 1 pulses.

e 3. Zoom in closely around the last marker pulse and set
a marker.

e 4. Zoom out, then zoom in around the end of the XMTR
gate 1 pulses and set the marker to 1.5 s after the
previous marker. Enter a comment “End of scan” at this

oint. This should be one more “slice interval” after the
ast XMTR pulse.



Scroll to approximate end-of-scan time from method file.
This will be just after the block of physiological data for
that scan.
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Zoom in around the end of the scan.

o

i4—1 3. Click on the “Zoom”

icon.
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Zoom in closely around the last marker pulse.
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RF Pulses (V)
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Now, we can see each data point. Move the
cursor to the first data point of the marker
pulse, right-click and choose “Set Marker”.

Sampling

Last marker pulse

(start of 300t dynamic) \




Zoom out, then move the cursor until the time
display (top left) reads A1.5s. Draw a box just a little
to the left and right of this point to zoom in. Include
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Now move the cursor to exactly
A1.5s, right click and set a marker
and a comment: “End of scan”.
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/oom out and you should see
something like this:

{8 LabChart - [STM0654_C28_E_jwth_E9_times_KWF.adicht: Zoom View*] - x
File Edit Setup Commands Macre Window Help -

E-ele ABE B-& = BEEL i)
File Commands Data Pad Comments Window Layout Sampling
0| Ry | t= RF Pulses =
=]
4
9
z
=
8
2 o
&
E
@
g
4 ki
=
= &
=]
5 End-of-scan should appear “one slice” after last XMTR gate pulse
4
. "
=
z
& z
=3
=
1
-1
%36:53.2 AM 10:36:53.4 AM 10:36:53.6 AM 10:36:53.8 AM 10:36:54 AM 10:36:54.2 AM 10:36:54.4 AM 10:36:54.6 AM 10:36:54.8 AM 10:36:55 AM 10:36:55.2 AM 10:36:55.4 AM 10:36:55.6 AM 10:36:55.8 AM 10:36:56 AM 10:36:56.2 AM 1036564 0M 10:365
ol &

%3 | [ 50854 C28 E... 102168 W



Recommended procedure to find
true beginning-of-scan

e 1. Close Zoom window and return to Chart view.

e 2. Scroll to beginning of scan (block of continuous
pulses in XMTR gate 1 trace), then zoom in around
first four marker pulses.

e 3. Zoom in around the fourth marker pulse and
enter comment “Beginning of scan” at the
beginning of that pulse. The time counter should
read A =-7:30.207.



Return to Chart View and scroll until the time display reads

approximately A7:30. This is close to the beginning of the

scan. Zoom in on an interval a little before the first marker
h pulse.

pulse to a little after the fourt
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Now zoom in closely around the fourth marker
pulse, which marks the beginning of the first
fMRI dynamlc (after three dummy dynamlcs)
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01+

TR gate 1 (V)

Move the cursor to the beginning of the fourth

marker pulse, right click and add comment

Beginning of scan”. Time display should read

A-7:30.207 at this point.
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Quality Control Procedures



Checking data quality before
exporting

The “Resp Rate” and “Pulse Rate” (as well as SpO2 and FOT)
data are calculated by PC-SAM, converted to analog signals,
and digitized by PowerLab.

Sometimes, especially if the respiratory effort or pulse signal
becomes weak or changes suddenly in baseline, amplitude
or phase, PC-SAM may make an error in calculating the rate.

PC-SAM reports the running average respiration or pulse
rate over several cycles, so an error in calculating the
instantaneous rate may persist for several seconds.

Scroll through the data from beginning to end, checking for
continuous, smoothly varying respiration and pulse rate
within a sensible physiological range (respiration 30-100
BPM and pulse 250-400 BPM for rats).



Looking at the entire duration of
scan 9, all seems OK!
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In scan 10, there were some
anomalies worth checking out.
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Here, there was a single irregular breath, which caused
the calculated respiration rate to dip for about 10 s. The
pulse sighal and pulse rate also dipped, so this looks like a
real physiological event. No recalculation needed.
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Here, there was a brief acceleration in breathing, but
due to the moving time average, it isn’t evident in

the respirator
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This is a similar example, but here, the pulse
oximeter signal decreased briefly. This is due to
automatic gain adjustment of the pulse signal by
PC-SAM and is not a physiological anomaly.
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Here, as the respiratory effort signal gets smaller and
its baseline drifts, PC-SAM underestimates the
respiration rate. LabChart may be able to calculate
the correct rates here, after the fact.
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Calculating rate data in LabChart

 First, create a new channel to store the calculated
rate data: Setup -> Channel Settings

Channel Settings

On Channel Title Device Input Sample Rate Range Input Amplifier | Units | Color | Style Calculation
1 P-Resp Effort Input 1 (PowerLab 16/35) B~ — |~ | Mo Calculation -
2 Resp Rate Input 2 (PowerLab 16/33) M ~| — |~ | Mo Calculation -
3 Pulse Ox Wave Input 3 (PowerLab 16/35) I~ — | ~|Neo Calculation -
4 RF Pulses Input 4 (PowerLab 16/35) B ~| — = | Mo Calculation -
5 Sp02 Input 3 (PowerLab 16/33) B ~| — - | Mo Calculation -
& Pulse Rate Input & (Powerlab 16/35) B ~| — |~ | Ne Calculation -
7 FOT1 Input 7 (PowerLab 16/35) B ~| — |~ | No Calculation -
a Ti Input & (PowerlLab 16/35) I~ — |~ | Mo Calculation -
9 Supply CO2 Input 3 (Powerlab 16/33) M ~| — |~ | Mo Calculation -
10 Supply 02 Input 10 (Powerlab 16/35) I ~| — |~ | No Calculation -
1 ERT Gate Input 11 (Powerlab 16/35) B ~| — |~ | Mo Calculation -
12 lsoflurane Input 12 (Powerlab 16/33) B ~| — |~ |Multipoint Calibration... | =
13 XMTR gate 1 Input 13 {Powerlab 16/33) B ~| — |~ | Mo Calculation -
S _ 2. Name the new channel Ml 7| — 7| NoColculation M
15 Calculated resp rate y 4 T T B ~| — = | Mo Calculation -
5 ) /
- 3. Select “Cyclic Measurements...”
18 | | | [
1. Increase the number of
#®)  Number of channels: E/ Channels by 1‘ OK Cancel




Cyclic Measurements Window

Cyclic Measurements - Channel 15 Make sure that we are using the P-Resp Effort X
Setup / signal to calculate rate.
Source: |Ch1: P-Resp Effort v (®) Auto scale
() set scale 0 500
Measurement: | Rate - [ ]Event markers Dedmal places: (4 |2

Preview of detected cydes
el ol TS ST 800S0 S S 80 SIESE N SIS0 S 0S8 S S aTE S SIS E S S e 8T e T e O S e e -

w7 )
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L < Click here to display raw signal

Detection settings Detection adjustment
Preset: | General - Sine shape y Minimum peak height: | 2 = 5.D.
Customize. .. SaVE... Delete...
0.055.0. 95.0,

(7] Ok, Cancel




LabChart can correct baseline drift

Cyclic Measurements - Channel 153

Setup
Source : | Chi: P-Resp Effort i ® Auto scale
() set scal
Measuremen t: Rate > [ ]Event marke

Preview of detected cydles

‘asfi

=
-
+ J il | CEEELLELEELE i .
:04:10AM  11:04:20AM  11:04:30AM  11:04:40AM  11:04:50AM 11
=y L 2l 1 |
Y\J Click here to display raw and baseline-corrected signal.
Detection
Preset: | General - Sine shape y Minimum peak height: | 2 = 5.0.
Customize. .. Save... Delete. .. '
0.055.D. 55.D.
(8] Cancel




Use the zoom control and slider to locate
a region with bad rate data

Cyche Measurements - Channel 15 >
Setup Output
Source: |Ch1l: P-Resp Effort v (®) Auto scale
() set scale 0 500
M Li- . . . . -
Heasurement: |Rate Circles indicate detected breaths. | Dedmslpiaces:[4 |3
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Preset: [[EMMA—— - Minimum peak height: IZ = 5.0.
Customize... SAVE. .. Delete...
0,055.0 9 5.0,

Adjust Preset shape or go to “Customize...” to
© | | tune peak detection parameters

Ok Cancel




On closing the “Cyclic Measurements” and “Chart
Settings...” windows, the calculated respiration rate
is shown in the new, bottom trace.
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Exporting Data to a Text File



Challenges to exporting the
physiological data that exactly
correspond to each MRI scan

 When selecting data to export, you can’t position
the cursor with sufficient accuracy to exactly match
the true beginning and end of the scan.

* There doesn’t seem to be a way to zoom in and out
without clearing the selection.

e LabChart doesn’t seem to let you type in bounds
for exporting data.

* Since we do know the exact beginning and end
time, we can export data from a little before to a
little after the scan, then trim the data to the
correct times.




At a zoom factor of 1k:1 in LabChart, you can see the
entire record for one fMRI EPI scan. At this zoom
factor, the scan seems to contain a continuous block
of XMTR gate 1 pulses.

{2 LabChart - [STMOB54_C28 E iwth_E9_times KWF.adicht: Chart View (PowerLab 16/35]" - x

E-<8 Ai ek

FE EEE

File Edit Setup Commands Macro Window Help - & X

File Commands Data Pad Comments Window Layout Sampling
-] ks
= 4- ~ NoSsmpling
t Z- M P-Resp Effort
n.
= o0 — T ] T ——— T r———"————————-—— |~ No Sampling (7]
+ 50 M Resp Rate -
n.
b1 4 - = NoSampling
I I - -
= — s e ———————— e
£ ¥ Ne Samplin
;_ ol [T [T .RFPI“ g L
ulses hd
= 13
o
A ~ NeSampling
= 80 -
=] 60 - W spo2 -
hd S0 < ~ NeSampling
+ 200 Ml PulseRate v
=
A ~ NeSampling
+ 35 W FoTi -
= an -
A an- ~ NoSompling
3
T -
- 30 .
= L amarpsi s mruny ey RO e e R et ermpe ~ NoSampling @y
& 4 B SupphyCO2 v
A ~ NoSsmpling
+ 0 B Supply 02 -
< T O O O A A A A R R = M Semefing @
& 9 B ERT Gate -
0=
= ~ NoSampling @
1
+ ( Sca n 9 ) I Isoflurane -
= 0.
- 3 = NoSampling
+ NN N T [ N N I I O o -
P
~ ~ NoSampling
+ 0- W £CG -
= 100 ~ o =}
= a 3 E ~ NoSampling
+ 1 ra % £ I Colculated res... ~
&
M 10:27:00 AM 128 10:29:00 AM 5 10:30:00 AM 10:31:00 AM 10:32:00 AM 10:33:00 AM 10:34:00 AM 10:35:00 AM 10:36:00 AM 107 3 00 AM 7 138:00 AM 10:39:00 AM
h < >

] STMOB54_C28 E. 1ws4:8 i



On the XMTR gate 1 trace, select an interval
from just before the beginning of scan 9 to
just after end-of-scan, as determined earlier.
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Choose “File->Export...” and name the
exported text file. Next, adjust export
settings as shown below.

Export As Text et
Exporting all channels —| chemes:  [m@ <]
() Whole file
Ve ry i m po rtant !ﬁ (®) Current selection [ Block header
Out-ofrange data Columns
() Clip values Time
(@) Output MaN for values [] Always seconds
[]Date
Downsample =1 (or  —>Mpownzampleby: |1 $ Flcomments
unc h ec ke d ) . O 5 ms pe r [J1gnore regional settings Event markers
point, ca. 3000 rows per ) p—

dynamic, ca. 86 rows per
slice, ca. 900,000 rows
total
These settings export data from all channels at all sampled points in the selected
interval.
Pro: Users can see the logic pulses on channel (one per dynamic) and channel 13
(XMTR gate 1; one per slice) to precisely locate data.
Con: The resulting text file takes several minutes to export and is huge (128 MB!)



To save time and space, data may be
downsampled and only useful channels
exported.

Export As Text / Export just essential
Chomnes: | PEDERARD ] channels:
O wihoe fie 1. Respiratory effort
Very importantl—>| ®curentselection [JBlock header 2. Resp. rate (from PC-SAM),
Out-ofrange data Columns 3 Pulse OX Signal
() Clip values Time
(®) Output NaN for values [ ] Always seconds S. Spoz (from PC_SAM)
5 e by 20 _ Oosee 6. Pulse rate (from PC-SAM)
1sownsamp e‘ y ' ;D;:::i:gpiluenj:setﬁngs : i Ej:nr:l::kers 7 ReCtal temp (FOTl)
Tgoper point I ) 9. Exhaled CO2 (from CWE)
ca. rows per dyhamic @ Cancel 12. Isoflurane dose
ca. 3 rows per slice

ca. 30,000 rows total

Pro: Export much faster and exported text file is much smaller (2.6 MB).

Con: The time per point is too long to reliably digitize the logic pulses, so they are not
usable for locating individual dynamics or slices. However, these can be located by
calculating time from the beginning or end of the scan.



Using the start and stop times from the Comments
window in LabChart, trim the exported text file to
exclude data before dynamic 1 or after end-of-scan.

10:29:26.0346
10:25:26.0459¢
10:25:26.0646
10:29:26.079¢6
10:29:26.094¢
10:29:26.1096
10:29:26.1246
10:29:26.139¢6
10:25:26.154¢
10:29:26.169%96
10:29:26.1846
10:25:26.1959¢
10:29:26.2146
10:29:26.225%6
10:29:26.244¢
10:29:26.255¢6
10:29:26.2746
10:29:26.285¢
10:29:26.304¢
10:25%:26.3156
10:29:26.3346
10:29:26.345¢

10:36:56.2556
10:36:56.274¢
10:36:56.289%9¢
10:36:56.3046
10:36:56.31%¢
10:36:56.334¢
10:36:56.345%¢
10:36:56.364¢6
10:36:56.37%¢
10:36:56.354¢
10:36:56.4096
10:36:56.424¢6
10:36:56.439¢
10:36:56.454¢6
10:36:56.46596
10:36:56.4846
10:36:56-499¢6
10:36:56.5146
10:36:56.5296
10:36:56.544¢6

4.745729 B6.41066 2.754891 90.82231 255.104 37.52354 1.433104 0.3507409
4.076833 B6.40427 3.756031 50.80211 255.1147 37.52243 1.414223 0.3506737
3.355292 B86.35787 4.127583 50.80413 255.104 37.52077 1.382516 0.3507185
2.791656 B86.39787 4.023927 90.792 255.11e8 37.52243 1.382802 0.3506177
2.338062 B6.37653 3.692177 90.81019 255.1125 37.52077 1.367673 0.3505953
2.001156 B86.38507 3.302349 90.792 255.0933 37.5228 1.363289 0.3507074
1.759229 B86.40853 2.949573 90.79604 255.1147 37.51985 1.342328 0.3507522
1.537427 B6.38507 2.655411 90.81221 255.1189 37.52243 1.339331 0.3506737
1.360527 B86.35787 2.377349 50.81019 255.11€8 37.52188 1.3388 0.3506961
1.221708 86.39147 2.122615 50.81827 255.1083 37.52022 1.335086 0.3507074
1.140906 B86.38934 1.854312 90.80817 255.1253 37.521€9 1.3390€6 0.3506737
1.09474 B6.38253 1.572677 950.81827 255.104 37.52243 1.339127 0.3506513
1.0594729 86.39147 1.315584 90.81625 255.11€8 37.52077 1.335066 0.3507857
1.087917 86.4064 1.03el5¢e 90.81019 255.1125 37.5218s8 1.3387¢ 0.3507409
1.054548 86.4152 0.82672%2 50.81423 255.0997 37.5z022 1.33806¢ 0.350774¢
1.055042 86.40853 1.287203 50.83039 255.1211 37.52243 1.362718 0.350e177
1.027083 Be.3872 2.783568 90.80413 255.118¢9 37.52372 1.38z2781 0.3505729
0.975375 86.38934 3.870443 90.81019 255.123z2 37.52114 1.415772 0.3507409
0.9206563 86.37653 4.276l4¢ S0.81221 255.11e8 37.51%85 1.448457 0.350e85
0.B5686.3744 4.163818 S50.77584 255.0784 37.52169 1.48416 0.3506626
0.7924895 B86.37866 2.7e9099 90.81e25 255.1147 37.52077 1.50822 0.3507522
0.7595537 86.37633 3.331729 90.82029 255.1147 37.52151 1.533075 0.3507522
3.460573 94.54934 1.186984 895.8603% 253.0304 37.49975 1.705023 0.3515703
3.800552 94.56¢64 0.9491146 B89.8664¢6 253.038¢8 37.49754 1.706104 0.351¢6151
4.16l¢65¢ 54 .54507 1.268573 85.85837 253.045%¢ 37.459754 1.71472% 0.3517833
4.622021 54.562.477125 85%.86039 253.0453 37.45938 1.715218 0.3516264
4.967844 94.55573 3.6288595.86039 253.0347 37.500e7 1.722865 0.351leB24
4.98738¢ 94.54293 4.158734 89.85231 253.0325 37.49901 1.724577 0.351e824
4.58738¢ 54.52587 4.146609 85.84221 253.0283 37.45772 1.724801 0.351604
4.98724 54.5408 3.8B36568 BS5.83008 253.0261 37.45808 1.724524 0.3516264
4.987344 94.5344 3.412854 89.85635 253.0304 37.49625 1.7251z28 0.351¢6151
4.970729 94_5472 2.967484 85.85837 253.0048 37.45717 1.725148 0.3515478
4.636521 54.54534 2.58588 B9.84827 253.0368 37.458¢64 1.725128 0.35166
3.988979 94.56427 2.2089448 895.85231 253.0283 37.50048 1.724985 0.3517385
3.389271 94.562.072219 B89.8806 253.0261 37.4992 1.724924 0.3517272
2.869583 94.5408 1.84¢6417 89.86038 253.0388 37.49717 1.724544 0.351772
2.45714¢ 94._53013 1.621781 B9.B6242 253.0432 37.4992 1.725005 0.3517161
2.184333 94.5472 1.391734 89.86646 253.0517 37.49957 1.724129 0.3516713
1.5942625 94 _538¢66 1.150255 89.87454 253.02€1 37.4984¢ 1.715381 0.3516151
1.764958 94_.53227 0.9317917 BS.8806 253.049¢6 37.49735 1.701435 0.3515703
1.637823 94.528 1.436812 89.87252 253.024 37.49994 1.678496 0.3515703
1.552115 94_538¢66 2.778198 89.85433 253.0176 37.49957 1.670993 0.3515927

Delete rows before dynamic 1
~ (start time = 10:29:26.218601)

=

§* Begin scan 9

$* End of scan 9

Delete rows after dynamic 300
(end time = 10:36:56.424601)



When importing data into Excel, specify
first (time) column as text since Excel
times do not show fractional seconds.

Text Import Wizard - Step 3 of 3 ? >

This screen lets you select each column and set the Data Format.
Column data format

Dgeneral
‘General’ converts numeric values to numbers, date values to dates, and

all remaining values to text.
() Date: | MDY w Advanced...
{:} Do not import column [skip)

Drata preview

Zenera Zepezgl Cepergl Lepergl Cepergl |
_084729 |BE.39147 [l 2315584 [90.21€25 PES_11&8
_087917 BE.40€4 [l _03€15¢ [B0.8101% PE5_1125
.054%948 |BE€.41%2 |[J.52€7252 [30.51423 P55.0937
_055042 |BE.40853 [l 387203 [90.2303% PE5.1211
_027083 |BE.3872 [ .7835€8 [90.20413 PE5_118%

Cancel < Back Mext =




Final result: Physiological

data for E9!

B Autosave @ off) £~ =

STMO654_C28 E downsampled_30X_selected channels trimme... ~

®@ - o x

File Home Insert  Page Layout Formulas  Data  Review View  Automate Help  Acrobat |.I;| Comments |

ﬁj A [Aptos Narrow V“Z' A A f | & |_w| [l Conditional Formatting ~ B Insert ~ > v v~ E(}

Paste Da i B I U~ . M. A = /] = - $ v % 9 ﬁ}; Format as Table ~ & Delete ~ v /O v Add-ins | Analyze Adobe Borders

M < - = = 3= '!\’7' - ‘_‘0'8 _)08 @ Cell Styles ~ ﬂ Format ~ 6} - Data Acrobat ~ M
Clipboard ] Font ] Alignment ] Mumber ] Styles Cells Editing Sensitivity Add-ins Mew Group o
L8 ~ fx w
A B C D E F G H | 1 K L M N o
1 Time Resp. effort, V Resp. rate, BPM Pulse ox signal Sp02, % Pulse Rate, BPM Rectal Temperature, C Exhaled CO2, % Isoflurane, %  Comments 0
2 |10:29:26.2146 AM  1.094729 86.39147 1.319984 90.81625 255.1168 37.52077 1.339066 0.3507857 #* Begin scan 9
3 |10:29:26.2296 AM 1.087917 86.4064 1.036156 90.81019 255.1125 37.52188 1.33876 0.3507409
4 110:29:26.2446 AM  1.054948 86.4192 0.8267292  90.81423 255.0997 37.52022 1.339066 0.3507746
5 |10:29:26.2596 AM  1.055042 86.40853 1.387203 90.83039 255.1211 37.52243 1.362718 0.3506177
6 |10:29:26.2746 AM  1.027083 86.3872 2.783568 90.80413 255.1189 37.52372 1.382781 0.3505729
7 |10:29:26.2896 AM  0.975375 86.38934 3.870443 90.81019 255.1232 37.52114 1.415772 0.3507409
8 |10:29:26.3046 AM  0.9206563 86.37653 4.276146 90.81221 255.1168 37.51985 1.448457 0.350685 [:-_-:_1
9 |10:29:26.3196 AM 0.856 86.3744 4.163818 90.77584 255.0784 37.52169 1.48416 0.3506626
10 | 10:29:26.3346 AM  0.7924895 86.37866 3.769099 90.81625 255.1147 37.52077 1.50822 0.3507522
11 1 10:29:26.3496 AM  0.7595937 86.37653 3.331729 90.82029 255.1147 37.52151 1.533075 0.3507522
12 110:29:26.3646 AM  0.7382708 86.38507 2.949682 90.81019 255.1019 37.52169 1.566474 0.3506402
13 110:29:26.3796 AM  0.672177 86.37227 2.655359 90.80615 255.1083 37.52169 1.5971 0.3507074
14 110:29:26.3946 AM  0.6388438 86.38934 2.393635 90.81625 255.1211 37.52243 1.632884 0.3506177
15 110:29:26.4096 AM  0.6190104 86.3616 2.140693 90.81019 255.1061 37.52188 1.648401 0.3505616
16 1 10:29:26.4246 AM  0.6476875 86.38293 1.856172 90.82231 255.1125 37.52243 1.676763 0.350584
17 110:29:26.4396 AM  0.6800625 86.4064 1.587724 90.82029 255.0955 37.52206 1.683634 0.3505505
18 1 10:29:26.4546 AM  0.7263229 86.40427 1.29138 90.81625 255.0997 37.52169 1.706002 0.3505953
19 1 10:29:26.4696 AM  0.7778333 86.3936 1.011359 90.83646 255.1339 37.52169 1.706267 0.350584
20 1 10:29:26.4846 AM  0.8477396 86.39573 0.8859115  90.81423 255.1211 37.52077 1.7153 0.3506402
21 10:29:26.4996 AM  1.008635 86.38934 1.596552 90.83646 255.1168 37.52243 1.715361 0.3506961
22 110:29:26.5146 AM  1.175177 86.38293 2.98688 90.81423 255.1467 37.52133 1.715177 0.3505503 o
STMO0654_C28 E_downsampled_30X_s IZ'_-EZI eL_____________________________________________________________________NJ

Select destination and press ENTER or choose Paste
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	Extracting Physiological Data for STARRRS fMRI Scans
	Background
	Post-processing in LabChart
	Challenges to Matching Physiological to MRI Data
	Locating the Beginning �and End of a Scan
	Step 1: Look up the scan numbers in the Scan Record spreadsheet for the desired cohort and time point.
	Step 2: Locate the method parameter file for the scan of interest.
	Step 3: In the LabChart record, locate the end of the scan of interest.
	In LabChart, set X axis to time of day
	Scroll to approximate end-of-scan time from method file, then move mouse in data window to display exact time at top left. Right click and select “Set Marker”.
	Let’s zoom in around the end of scan 9.
	Now we can see the logic pulses for each slice. The end-of-scan time from the method file is 0.524 s after true end-of-scan. Unfortunately, this is not an exactly reproducible delay (0.498, 0.5185, 0.586, �0.595 s…). This variability may arise from variable latency in writing data to disk.
	So the end-of-scan time from method is just approximate, but good for identifying the correct block. In the zoomed view, mark the actual end-of-scan.��
	Mark the true end-of-scan with a comment. The exact time is saved by LabChart.
	Press Ctrl-L or choose “Window -> Comments” to display comments.
	Step 4: Locate the beginning of the block of data to export.
	Step 4: Locate the beginning of the block of data to export.
	Zoom in on the first five marker pulses �in channel 4.
	Again, we can see the logic pulses for each slice. The actual time between marker pulses is not 1.5 s but longer by 0.5-1.0 ms (digitization rate of 0.5 ms/point). This difference accumulates so that the true beginning of scan is more than 450 s before true end of scan. This difference of 207 ms seems to be consistent.
	Conclusions: Locating ends of data block
	Recommended Procedure for Marking Beginning and End of Scan
	Recommended procedure to find true end-of-scan
	Scroll to approximate end-of-scan time from method file. This will be just after the block of physiological data for that scan. 
	Zoom in around the end of the scan.
	Zoom in closely around the last marker pulse.
	Now, we can see each data point. Move the cursor to the first data point of the marker pulse, right-click and choose “Set Marker”.
	Zoom out, then move the cursor until the time display (top left) reads D1.5s. Draw a box just a little to the left and right of this point to zoom in. Include the last two or more XMTR gate 1 pulses .
	Now move the cursor to exactly D1.5s, right click and set a marker and a comment: “End of scan”.
	Zoom out and you should see something like this:
	Recommended procedure to find true beginning-of-scan
	Return to Chart View and scroll until the time display reads approximately D7:30. This is close to the beginning of the scan. Zoom in on an interval a little before the first marker pulse to a little after the fourth pulse.
	Now zoom in closely around the fourth marker pulse, which marks the beginning of the first fMRI dynamic (after three dummy dynamics).
	Move the cursor to the beginning of the fourth marker pulse, right click and add comment: “Beginning of scan”. Time display should read �D-7:30.207 at this point.
	Quality Control Procedures
	Checking data quality before exporting
	Looking at the entire duration of scan 9, all seems OK!
	In scan 10, there were some anomalies worth checking out.
	Here, there was a single irregular breath, which caused the calculated respiration rate to dip for about 10 s. The pulse signal and pulse rate also dipped, so this looks like a real physiological event. No recalculation needed.
	Here, there was a brief acceleration in breathing, but due to the moving time average, it isn’t evident in the respiratory rate trace until several seconds later.
	This is a similar example, but here, the pulse oximeter signal decreased briefly. This is due to automatic gain adjustment of the pulse signal by PC-SAM and is not a physiological anomaly.
	Here, as the respiratory effort signal gets smaller and its baseline drifts, PC-SAM underestimates the respiration rate. LabChart may be able to calculate the correct rates here, after the fact.
	Calculating rate data in LabChart
	Cyclic Measurements Window
	LabChart can correct baseline drift
	Use the zoom control and slider to locate a region with bad rate data
	On closing the “Cyclic Measurements” and “Chart Settings…” windows, the calculated respiration rate is shown in the new, bottom trace.
	Exporting Data to a Text File
	Challenges to exporting the physiological data that exactly correspond to each MRI scan
	At a zoom factor of 1k:1 in LabChart, you can see the entire record for one fMRI EPI scan. At this zoom factor, the scan seems to contain a continuous block of XMTR gate 1 pulses.
	On the XMTR gate 1 trace, select an interval from just before the beginning of scan 9 to just after end-of-scan, as determined earlier.
	Choose “File->Export…” and name the exported text file. Next, adjust export settings as shown below.
	To save time and space, data may be downsampled and only useful channels exported.
	Using the start and stop times from the Comments window in LabChart, trim the exported text file to exclude data before dynamic 1 or after end-of-scan.
	When importing data into Excel, specify first (time) column as text since Excel times do not show fractional seconds.
	Final result: Physiological data for E9!

	DisclaimerBox0: Persons using assistive technology may not be able to fully access information in this file. For assistance, e-mail AgingResearchBiobank@imsweb.com. Include the website and filename in your message.


